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Big Bear, California 

Itôs amazing how fast this year is 

going by, I cannot believe that win-

ter is just around the corner.  The 

Big Bear Computer Club has been 

growing by leaps and bounds, we 

hope to continue with our training 

sessions.  We are planning on hav-

ing on occasion guest speakers so stay tuned. 

Just to give you heads up, last year we had to cancel 

a meeting because the Discovery Center was not 

snow plowed.  Should this happen this year, we 

have an alternate meeting place and that would be 

the Shepherd of the Pines Lutheran Church, located 

at 42450 North Shore Drive in Big Bear City.  The 

only problem is that it would be moved from the 

second Tuesday to the second Wednesday.  We will 

give notify everyone of the change which would be 

at the last minute. 

The Board is planning our Holiday Party for De-

cember 9th.  The Club will provide the turkey and 

ham while you will bring the trimmings.  Donôt for-

get to sign up at our November 11th meeting.  We 

will have a gift for everyone so donôt miss out. 
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October General Meetingð 

By:  Rosemary Lloyd 

At this monthôs meeting our presenter was Mike 

McCort from Cyber Specialists International (CSI).  

His company specializes in data recovery and com-

puter forensics.  They work with law enforcement by 

collecting computer data, analyzing it and preserving 

evidence.  Also, the company can assist individuals 

with recovering lost data on their computer.  Deleted 

files can be recovered; so can files on a physically 

damaged hard drive.  Mikeôs talk was very enlight-

ening.  He showed us many elements involved in the 

process of recovering data from computers.  Other 

topics covered were how child predators use the so-

cial networking sites like Facebook, MySpace, etc.  

The bad guys pretend to be young people looking for 

friendship.  In the course of any type of investiga-

tion, Mike is required to report any child porn found 

to the authorities.  Meanwhile, millions of dollars 

are lost due to Internet fraud and identity theft annu-

ally.  He gave us some tips on how to protect against 

these maladies. 

 

After the break, member Jack Koch showed us some 

videos and slide shows that he and his granddaugh-

ter made.  Jack explained that he added sound and 

edited the video using a program that came with his 

computer.  It is very easy to do.  Jack demonstrated 

that video and photo editing can be done by begin-

ners as well as experienced computer users.   

Members wrote questions for the RAM session.  Jim 

Applebury used his expertise to give some answers.  

As always, it was educational.  

 

 

Criminal Law  

Personal Injury 

Family Law 

Workersô Compensation 

Philipson & Erdmier 
Attorneys 

719 Pine Knot Avenue     Big Bear Lake, CA 92315 

Itôs that time of the year where we need to 

start thinking of electing officers to carry on 

the Computer Club traditions.  Our elections 

are in Decemberé.this is not too early; if 

you are interested in getting more active 

within the Computer Club, we want to hear 

from you.  There is a job for everyone that 

wants to get involved just let me know.    

ElectionsðYomar Cleary 

Bearly Bytes, past winner of SWUGC & APCUG 

Newsletter contests. is the official publication of the 

Big Bear Computer Club. Views expressed in Bearly 

Bytes are those of the authors and do not necessarily 

reflect the opinions of Big Bear Computer Club. 

Other computer user groups are welcome to reprint 

our articles as long as they give credit to the author 

and Bearly Bytes, Big Bear Computer Club. 

Submissions: All BBCC members are encouraged to 

send letters, articles, questions, and comments to 

Bearly Bytes for inclusion in future issues. Submit 

as plain text in the body of an email and attach any 

graphics as JPEG or GIF format. Send to Yomar 

Cleary 

Bearly Bytes information 
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Well, I had more fun with my 

computer. They said I had to  

back up all my data and then 

 restore it to the factory image.  

This was easy enough, BUT 

the back up didnôt work and I 

didnôt know it until I tried to restore.  Found a little 

bit so Iôll live. Probably saved too much anyway. 

I learned something new too...donôt move your ex-

ternal hard drive around unless it is turned off. No 

one told me that so I wiped out the one that was do-

ing my backups automatically with my Vista. On 

and on it goes, huh.  Happy Thanksgiving. 

Editorôs Corner 

We have a suggestion box at our meetings for mem-

bers to express what they like about the club and what 

they would like to see improvement. Take the time 

and let the board know what types of presentations 

you like to have or what you would like to see in your 

Bearly Bytes newsletter and even our website. Take a 

few minutes to fill out a form and deposit in the Sug-

gestion Box. 

Suggestion Box 

   11 November Meeting Discovery Center      

   

 25  Board Meeting 1:30 @ Dennyôs 

    

27  Thanksgiving 

December 2008  

S U M O T U W E T H F R S A

 1 2 3 4 5 6 

7 8 9 10 11 12 13 

14 15 16 17 18 19 20 

21 22 23 24 25 26 27 

28 29 30 31    

November 2008  

S M T W T F S A

      1 

2 3 4 5 6 7 8 

9 10 11 12 13 14 15 

16 17 18 19 20 21 22 

23 24 25 26 27 28 29 

30       

   9 November Meeting Discovery Center  

 

   23 Board Meeting 1:30 @ Denneyôs 

 

   25 Christmas 

 

   31  New Yearôs Eve 
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Big Bear Computer Club Review  
By Yomar Cleary  

 

Price: $679.95    Microsoft Office Ultimate 2007  

System Requirements:  

Computer & Processor:   500 megahertz or higher  

Memory:     256 megabyte Ram or higher  

Operating System:  Microsoft Windows XP with Service Pack (SP) 2, Windows 

Server 2003 with SP1, or later operating system  

Hard Drive:  3 gigabyte; a portion of this disk space will be freed after 

installation.  

Manufacturer:     Microsoft  

Website;  http://office.microsoft.com/en -us/suites/FX101674121033.aspx   

It was exciting to install Microsoft Office Ultimate 2007 but at the same time, I was intimidated.  Set up was 

a breeze and only took 20 minutes on a Windows XP computer.  The new Ribbon interface design demands 

a steep learning curve and my job requires the constant use of Microsoft Word, Excel and Publisher, so I was 

nervous that I would not be able to keep up with my workload.  As it turned out it was not as difficult as I 

thought; but then I did go through the Microsoftôs on-line teaching video.   The Ribbon Interface across the 

top of Word, Excel, PowerPoint and most areas of Outlook gives a quick access to dozens of features.  The 

Ribbons introduced me to tools and commands I did not know existed. Even though each of the applications 

was upgraded, the basics are the same, so it was a little easier to do the changeover.  The fact that earlier ver-

sions of these programs opened without a hitch, was great.  This software is best suited for all levels of ex-

pertise. 

2007 OUTLOOK 

Outlook has many great features but when I tried to import my contact list from Outlook Express to Outlook, 

I found that it did not import my ñGroup Contactsò.   I have over 600 contacts of which most are in Groups.  

(Continued on Page 5) 
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(Office Ultimate 2007 continued from Page 4) 

I was disappointed that 2007 Outlook did not remedy this.  The new Outlook has improved task and time 

management and the new scheduling abilities make it a handier communications hub.  A new feature in Out-

look that I really like is sending text messages to cell phones and PDAôs.  Outlook still has the drop down 

menu feature but does have the ribbon interface in some of the sub-menu and working windows.  A new fea-

ture is the right hand pane entitled, ñTo Doò bar.  This feature helps you see your email, as well as my ap-

pointments at the same time.   

2007 WORD 

Even though I viewed the training video on line, it still was frustrating trying to find the right tool bar 

(Ribbon) to complete an action so my documents took a little longer than usual to complete.  My other con-

cern was sharing my files with other people who did not have Office 2007.   I could have asked them to 

download the free 2007 Office Compatibility Pack but this is an inconvenience to them.  I was delighted to 

find that I could save my documents in either the XML format or save in previous format: Word 97 thru 

2003 which everyone could open.   The fonts and margins are easy to manage through the galleries.  A great 

feature is the real time word count.  I was a bit confused as to why Spell Check was moved to, ñReviewò tab, 

while Headers & Footers were moved to the, ñInsertò tab from the View menu.  This is where the learning 

curve comes into play. 

2007 ACCESS 

Access stayed pretty much the same other than the introduction of Share Point.   I know and heard that Ac-

cess is a great program, but I personally like using Microsoft Excel and did not have anything to test in the 

2007 Access application.     

 2007 EXCEL 

I use Excel extensively so I was apprehensive as to the changes but I was pleasantly surprised that the graphs 

have been extensively updated and modernized.  I found that the formulas are now easier to reference. One 

thing I noted is that the 2007 Excel has placed so many more features within easy reach.  Best of all, there is 

now a web-based support for users of Excel 2007; including flash-based tutorials for finding specific features 

when you find yourself perplexed. Someone with limited knowledge of Excel can find this helpful. 

2007 POWERPOINT 

At last PowerPoint presentations can now be made more attractive.  The new interface rearranges every 

function you may have memorized, and the file formats are different. Plus, while you can hide the Ribbon by 

double-clicking on a tab, there's no going back to a "classic" view of PowerPoint that better resembles 2007's 

predecessors. The new program is more visually focused, so colorful icons describe many features. Power-

Point 2007 adopts the tabbed, top-heavy. The File menu is gone, its commands moved beneath the Office 

logo in the corner. I was perplexed by the arrangement of some features on the Ribbon, mostly with features 

that we expected to be on the Insert tab. New Slide is on the Home tab, not on Insert, for example. Many tabs 

won't appear until you select an item on the page. Clicking on a picture triggers the Picture Tools formatting 

tab to display. The same process applies when working with images, sounds, charts, drawing tools, and 

SmartArt. (Continued on Page 6) 
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2007 GROOVE 

Microsoft Groove 2007 sounds like a great program for business people to communicate with each other 

and work as a team to complete projects on time and share information through the internet at anytime, 

anywhere and stay up-to-date.  As it turns out, I am not in the business world so I will not be able to im-

plement this fantastic program. 

2007 MICROSOFT INFO PATH 2007 

I am involved in various groups and I am always developing forms; so I was delighted to find InfoPath as 

part of Office 2007.  InfoPath has the ability to fill in forms and can be submitted via email, and to pub-

lish forms to a Web server and have users fill them in there without needing InfoPath installed on their 

PCs.   I really appreciate the fact that Info Path Wizard converts forms designed in earlier Microsoft 

Word or Excel into its format without having to redo the forms.  Microsoft has made fill-in form design 

easier, including a multiple-selection list box and a horizontally repeating table. 

ONE NOTE 2007 

This application does so much that I could not sit down in front of the computer and do something pro-

ductive immediately.  This is a new tool for me as I see its usefulness relates to collecting, organizing 

and communicating information which can be shared across several computers on a network.  This pro-

gram is great for businesses.  I found that it works closely with Outlook, Smartphone and Pocket PCôs.   I 

could hardly believe that I can even print documents into OneNote.  On your computer, go to ñPrintersò 

where you will find a list of printers of which one is entitled, ñSend to OneNote 2007ò.  I just barely 

touched the tip of the iceberg of how you can use OneNote.  I look forward to learning all that OneNote 

can accomplish.  (Continued on Page 12) 

ACCOUNTING EXPRESS 2007 

This program, Accounting Express, seemed to have borrowed a few design concepts from QuickBooks 

 I found that it is easy to setup and manage accounting basics, i.e. invoicing, payments, general 

ledger, accounts payable, and online banking.  Another feature I found is that you can import data from 

Microsoft Money and Excel, as well as from Intuit QuickBooks.  Itôs a great program for small busi-

nesses.  I have been busy trying to learn the various Office 2007 applications so I have not had a chance 

to set this up for my personal use.   

CONCLUSION COMMENTS  

Microsoft Office 2007 Ultimate was awesome as I went through each of the suite applications.  I was not 

able to go through all the applications in depth but those applications I worked on were amazing to use 

because they were user friendly.  I found that this particular program ñUltimateò had many advantages 

for both the personal and small business user with the various business applications for a reasonable 

price.  The new Ribbon interface in most of the Office 2007 applications is not only attractive but user 

friendly.   I certainly recommend Office 2007 from beginners all the way to advanced computer users.  

There is something for everybody.  Good job Microsoft!! 
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Instead of listing a few review programs that are avail-

able, I would like to inform you that any program you 

are interested in and would like to install on your com-

puter is probably available for review. All you have to 

do is ask for it and review it. The program could be on 

landscaping, any kind of crafts, digital photos, video, 

any kind of home decorating, games, office or ac-

counting programs, gift cards, label, and printshop 

programs, any program you are interested in having. 

All you have to do is let me know which program you 

would like to review. I will then contact the vendor 

and it takes about 10 days to receive the program. 

Sometimes the vendor will grant the reviewer a license 

online and all the reviewer has to do is download the 

program. Reviews are not hard to write; in fact they 

are quite easy. You are given instructions on how to 

write a review plus I have many samples you can look 

at. Also if you need any help all you have to do ise-

mail or call me. Writing a review is like telling some-

one about the new program you just received. You tell 

them what you like about the program, what you donôt 

like, and how the program could be better, thatôs it. 

Thereôs your review. And you can review books, also. 
ƴ 

ð Karen Tangeman, Review Editor 

Member Product Review Program 

Rosemary Lloydð1 2XL Black Tshirt by AMD 

Donald MelineðDiskeeper 2007 by Diskeeper Corp 

Jerry MerinoðClick 2 PDF by Blue Squirrel 

Phyllis JaegerðPictureshow 4 by Ulead 

Bill Flanaganð Won the 50/50 & bottle of wine 

Ray NormanðThe New School of Information        

Security Book by Addison Wesley 

October Door Prize Winners 
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4 Things to Consider When Buying A Laptop  

By Bryan Lambert  -   By Larry Smith  

With laptops now well established, and having a 

commanding share of the computer parts market, it 

is only fair to consider a few points when purchas-

ing your new laptop computer.  When we are talk-

ing ñlaptopsò, (or as some prefer to call them, 

notebooks), buyers today have a virtual cornucopia 

of extras and features to choose from.   

1) Primary Functionality  

A favorite mantra of mine to any who are consid-

ering which laptop to purchase (really, this would 

apply to desktops computers as well) is asking 

yourself: What are you planning to use the com-

puter for?  The answer to this question in many 

ways dictates the direction to focus your computer 

buying attention.  Are you planning on gaming or 

just tooling around the Internet? Is it for the kids' 

homework, or is it something that needs a bit more 

power to do some video editing?  A computer 

bought for the kids' homework may only need a 

low end (basic) processor, while something for 

gaming would call for a far more powerful proces-

sor.  For many people, it is a delicate balance of 

performance and pocketbook.   

2) Who Made What? 

Most of the laptops sold today are actually made 

by a handful of Taiwanese companies.  The top 

five companies (Quanta, Compal, Wistron, Inven-

tec, and Asus) actually manufacturer over 85% of 

all laptops sold worldwide.  All the top tier com-

puter ñmanufacturersò (for example: Acer, Apple, 

Dell, HP/Compaq, Gateway, Fujitsu, Lenovo, 

Sony, Toshiba, etc. etc) generally are not really 

ñmanufacturingò laptops per se, but rather con-

tracting one or more of these companies to manu-

facturer their laptops for them.  Because such a 

small number of companies make the majority of 

laptops today, the modern laptop is essentially a 

commodity product, differentiated by its features 

and casing ï the internal components are pretty much 

the same. The good news in all of this is that top tier 

manufacturersô laptops pretty much have the same reli-

ability ï the bad news if when an ñoopsò occurs, (such 

as the recent issue with nVidia video chipsets it tends to 

affect more than just one computer manufacturer. 

 3) Faster, Higher, Stronger 

With the delicate balance of performance and pocket-

book to keep in mind, the three BIG things that will 

determine your laptop's performance out of the gate 

will be: processor, memory, and video. Other things 

will affect it as well, but these seem to be the ñbig 

three.ò  

 Processors 

Mainstream high-end processors are generally consid-

ered to be the Intel Core 2 Duo with the AMD Turion 

64 X2 coming up behind it. The mainstream middle-

end processors would be the AMD Athlon 64 X2 and 

the Intel Pentium Dual Core. If at all possible, and in 

that order, these four proceeding processors would be 

the ones to look for.  That being said, the mainstream 

bargain (the nice way of saying ñlow-endò) processors 

would be the Intel Celeron Dual Core, Intel Celeron M, 

and AMD Sempron. Both AMD and Intel use model 

numbers for their processors (to distinguish as the core 

use, processor megaHertz, bus speed, and cache) and 

these can be confusing.  Iôd recommend using a table 

(such as many that are found on Wikipedia.org) to be 

able to differentiate, say, a T5550 from a T7200.  

 Memory 

Computer memory is pretty simple ï the more you                              
     (Continued on Page 9) 
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AZTECA GRILL  
Open Daily 

11:00 am - 9:00 pm 

DINE IN  

TAKE OUT  

CATERING  
40199 Big Bear Blvd. 

Big Bear Lake 

California 

909 866-2350 

(Continued from Page 8) 

have the better it goes. One Gigabyte of RAM is 

usually considered the starting point that youôd 

want to look at, 2GB is even better (except on bar-

gain units, where 512 megabytes would be ok).  

 Video  

On video memory, the way the market currently 

stands, there are two distinct options:  using a 

ñdiscreteò (separate) video chipset with dedicated 

memory, or using an ñintegratedò video chipset 

that shares the computer main memory.  ATI and 

nVidia offer discrete chipsets of various flavors 

and amounts of dedicated memory, while Intel, 

ATI and nVidia all offer integrated solutions. Gen-

erally speaking, discrete video chips perform much 

better in gaming (in fact, gaming is not really rec-

ommended when using integrated chipsets), video 

editing, etc.  If you plan to use your laptop for  

e-mail, writing and surfing the web, then getting a 

laptop with a discrete chipset would be a waste of 

money. 

4) Itôs Small and Cheap é It Must Be Good?? 

One of the big trends currently is small, very, basic 

cheap laptops commonly called ñNetbooksò.  

These are ultraportable laptops with very basic 

processors (read that as ñslowò), low memory and 

hard drive capacity, and may include an operating 

system youôre not familiar with (read that as 

ñLinuxò). These laptops are great for travel and as 

a second laptop or for the kids ï but for any kind 

of serious computing, they are not really recom-

mended. 

Manufacturers have also been racing to get thin 

and light units to the marketplace such as the Ap-

ple MacBook Air and the Lenovo X300 laptops as 

well as using material other than plastic for the 

outer casing (such as carbon-fiber and magnesium 

alloy). Large screened desktop replacement and 

entertainment laptops are also popular models as  

 

well and usually feature extras such as a TV card, Blu-

ray player and remote control (sometime more than 

one!) Tablet and Convertible Laptops (ñnormalò lap-

tops whose screens flip around to become a tablet) 

also have their legion of followers as do the rugged 

industrial strength laptops such as Panasonicôs 

Toughbook series. 

Fait Accompli ï La Fin!  

Though by no means exhaustive, and some things 

painted in broad strokes, it is our hope that this Tech 

Tip will help you to navigate the rivers of uncertainty 

in the laptop jungle and help you reel in the perfect 

laptop!       

                                                                                    




